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Chapter 33: Text Tool

Text Tool 
What it does
The Text Tool is used to enter blocks of text—not only the title of your piece, but also any headers, 
footers, page numbers, copyright notices, performance notes, and similar text that appears on one 
or more pages—directly into the score; adjust, align, and position text blocks; and set fonts and 
styles for the text directly on-screen.

Click the Text Tool to display a menu for editing text, the Text Menu. Use the Text Menu to spec-
ify fonts and styles for the text in a text block, to align a text block, apply special effects or shapes 
around the text block, assign a text block to a measure or to a page, and specify what page or 
range of pages you want text blocks to appear on.

The menus will display checkmarks for settings of the selected text blocks (such as 10 pt. and 
bold). If you have more than one setting such as mixed fonts or multiple text blocks selected with 
different settings, no selection in the menus will be displayed. Select a new setting to change the 
setting. Select Undo to reverse your action.

When no text block handles are selected, the menus show the default text block settings. These 
default settings can also be changed by selecting a new setting from the menu. You can undo the 
change by selecting Undo.

You can select more than one text block handle and apply settings to multiple text blocks as well 
as undo the changes you just made.

Editing inside text blocks can also be undone by selecting Undo from the Edit Menu. Changes 
made while in the Edit Text dialog box can be undone individually while in the dialog box. Once 
you have exited the dialog box, selecting Undo will revert the document to the state before enter-
ing the Edit Text dialog box.

Special mouse clicks
This list summarizes special mouse click actions for the Text Tool.

Mouse click What it does

Click the Text Tool The Text Menu appears. A handle appears on each text block in the score.

Click a text block handle or drag-enclose text 
block handles 

Select a text block or text blocks.

Shift-click a text block handle Add a text block to the selection. If a text block is already selected, remove 
the text block from the selection.

Double-click in the score Create an unbounded frame that expands as you enter text.

Double-click and drag in the score Create a bounded, fixed-size frame for text.



 

Text Menu 33-2      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter

                 
T

T

I

N
C

N
C

P
C

P
C

Contextual menus
Contextual menus are reached by right mouse-clicking on the handle of an object. A contextual 
menu will be displayed where you can select various items.

Text Menu
How to get there

To create or edit text blocks: Click the Text Tool [.

To edit a staff name: Click the Staff Tool s. Click a staff handle, then choose Edit Staff 

Attributes from the Staff Menu. Click Edit next to the full or abbreviated staff name in the Staff 
Attributes dialog box. (Or, ctrl-click a staff name handle on-screen.) The Edit Text window 
appears.

To edit a group name: Click the Staff Tool. Click a group handle, then choose Edit Group 
Attributes from the Staff Menu. Click Edit next to the full or abbreviated group name in the Group 
Attributes dialog box. (Or, ctrl-click a group handle on-screen.) The Edit Text window appears.

What it does
The Text Menu appears when the Text Tool is selected for editing text blocks directly on-screen, 
or when the Edit Text window appears for editing staff and group names. It contains options for 
editing text fonts, sizes, styles, justification and so on, displaying the text as it will appear on the 
screen and on your printed music.
You can change whether text blocks are assigned to a measure or a page, displayed on one or more 
pages, or displayed with a border around text in a standard frame, or within a custom frame. You 

Double-click a text block handle, or right mouse 
click the handle and select Edit Text from the 
contextual menu

Edit the text block. The frame surrounding the text appears. A cursor 
appears in the text block.

Shift-double-click a text block handle, or right 
mouse click the handle and select Edit Frame 
Attributes from the contextual menu

Edit the text block’s attributes. The Frame Attributes dialog box appears.

Press delete for one or more selected text blocks, 
or right mouse click the handle and select Delete 
from the contextual menu

Delete the selected text blocks.

Drag a selected text block handle Adjust the text block’s position in the score.

Text Block handles

Menu item What it does

Edit Frame Attributes Display Frame Attributes dialog box

Edit Text Display the Edit Text dialog box

Delete Delete selected text block

Mouse click What it does
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can also use this menu to change whether page-assigned text blocks are positioned from the page 
edge (or from the page margins), and how they are horizontally and vertically positioned on a 
page.

• Font: [Available Fonts]. Choose Font to display the Font dialog box, which lists all the fonts 
currently installed on your system. Select the font that you want to use. Finale highlights your 
selection in the Font list. If you want, you can specify other font settings in the Font dialog 
box. For details see FONT DIALOG BOX. 
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• Size:3 • ... • 72 • Other • Increase • Decrease • Fixed Size. Choose an option from the Size 
submenu for the font size for your text. Finale places a checkmark next to your selection. 
Choose Other to display the Size dialog box. See SIZE DIALOG BOX. Select Increase or 
Decrease (or use the keyboard shortcuts Ctrl-shift-period, and Ctrl-shift-comma.) to change 
the point size by one. Select Fixed Size to display the text at the specified point size, regard-
less of any reductions you’ve previously placed on a note, staff, staff system or page using the 
Resize Tool. (See RESIZE TOOL for information.)

• Style: Plain • Bold • Italic • Underline • Strikeout. Choose a type style from the Style sub-
menu. Finale places a checkmark next to your selection and applies the style to the selected 
text. Choose the command again to remove the checkmark and the style. Choose Plain to 
remove the checkmark from all other styles. You can choose any combination of styles (such 
as Bold—Underline, Italic—Bold, or a similar combination) from the submenu.

Note: Outline and Shadow styles do not appear in the Style submenu, since they are not sup-
ported in Windows; however, we provide them to provide compatibility across different plat-
forms in the Character Settings and Font dialog boxes. For details see CHARACTER SETTINGS 
DIALOG BOX and FONT DIALOG BOX.

• Baseline Shift. Use Baseline Shift to adjust the vertical position of the text without affecting 
the spacing between lines. See BASELINE SHIFT DIALOG BOX.

• Tracking. Choose this command to display the Tracking dialog box, where you control the 
amount of horizontal space, in ems, that Finale should leave between characters for the 
selected text. See TRACKING DIALOG BOX.

• Superscript. Use Superscript to adjust the vertical position of the text, adjusting the spacing 
between lines by the same amount. See SUPERSCRIPT DIALOG BOX.

• Character Settings. Choose this command to display the Character Settings dialog box, 
where you can specify all the settings for the selected text. For details, see CHARACTER SET-

TINGS DIALOG BOX.

• Inserts: Date • Time • Page Number • File Name • Composer • Title • Copyright • 
Descriptions • Sharp • Flat • Natural • Double Sharp • Double Flat • Symbol. When you’re 
creating or editing a text block, choose a command from the Inserts submenu to insert one of 
these items at the current location of the cursor. Finale pastes the current date, time, page num-
ber, or other insert at the insertion point. An outline appears around an insert to remind you of 
its special function. The following keyboard shortcuts are available for inserts:

Insert Keystroke

Page Number ctrl-shift-P

Sharp ctrl-shift-S

Flat ctrl-shift-F

Natural ctrl-shift-N
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Note: You can change character settings for inserts placed in text blocks (you might underline 
the date, for example). Simply select an insert you’ve placed in a text block (such as the date), 
then choose a font or other character setting from the Text Menu. Finale changes the entire 
contents of the insert to the new setting. You cannot, however, select and change the text 
within inserts.

You can change the content of individual Page Number inserts. Choose Edit Page Offset from 
the Text Menu to change the page number that appears for the selected page insert (other page 
inserts in the document are not changed).

Change the text in the File Info dialog box (in the File Menu) to change the information for 
the following inserts: Title, Composer, Copyright and Description.

You can also change the content of the following inserts: Sharp, Flat, Natural, Double Sharp, 
Double Flat. When you change the content of these inserts in the Text Inserts dialog box, 
Finale updates every insert of the same type throughout the document.

If you use a music font other than Maestro, you can change the symbol, font, baseline and 
tracking settings for the sharp, flat, natural, double sharp, and double flat signs by choosing 
Text Inserts from the Document Settings submenu in the Options Menu.

The Symbol insert will display the Symbol Selection dialog box allowing you to place the 
selected character into the text block. See SYMBOL SELECTION DIALOG BOX.

For more information, see Edit Page Offset, TEXT INSERTS DIALOG BOX, and FILE INFORMA-

TION DIALOG BOX.

• Edit Page Offset. Select a page number insert in a text block, then choose this command. The 
Page Offset dialog box appears, where you can enter a number to add to Finale’s current page 
number. See PAGE OFFSET DIALOG BOX.

• Standard Frame. This command is selected by default. Choose this command to display the 
Standard Frame dialog box, where you specify whether a border appears around the frame, the 
line thickness of the border, and the amount to inset the text from the frame. See STANDARD 
FRAME DIALOG BOX for details.

• Custom Frame. Choose this command to display the Custom Frame dialog box, where you 
select the positioning of text within or around a custom frame that you can create in the Shape 
Designer, and set the amount to indent the text from the frame. A checkmark by this command 
indicates that you’ve created a custom frame to surround the text. See CUSTOM FRAME DIA-

LOG BOX for details.
Note: If you choose Custom Frame, but leave Shape = 0 (no shape is selected) and H: and V:= 
0, Standard Frame will be selected when you return to the score.

• Justification: Left • Right • Center • Full • Forced Full • Expand Single Word. Choose 
Left, Right, Center, Full, or Forced Full from the Justification submenu to select how you want 
the text positioned in a frame. Choose Left or Right to place the text on the left or right edge of 
the frame, or choose Center to center the text between the left and right edges. Choose Full to 
spread the text evenly between the left and right edges of the frame, except for the last line, 
which is always left-justified. Choose Forced Full to spread the text evenly between the left 
and right edges of the frame, including the last line if it contains two or more words. Expand 
Single Word is selected by default when you choose either Full or Forced-Full justification.
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Expand Single Word works with the Full and Forced Full justification commands only. When 
Expand Single Word is selected and you choose Full justification, Finale spreads the text 
evenly between the left and right edges of the frame. In lines of text containing only one word 
(other than the last line), Finale spreads the letters of that word evenly between the left and 
right edges of the frame; if the last line contains only one word, that word is left-justified. 
When Expand Single Word is not selected, all lines containing a single word are left-justified.

When Expand Single Word is selected and you choose Forced Full justification, Finale 
spreads the text evenly between the left and right edges of the frame. In lines of text contain-
ing only one word, Finale spreads the letters of that word evenly between the left and right 
edges of the frame. When Expand Single Word is not selected, all lines containing a single 
word are left-justified. 

Full justified text with Expand Single Word selected:

 

Force full-justified text with Expand Single Word Selected:

  

Full-justified text without Expand Single Word selected:
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Force full-justified text without Expand Single Word selected:

   

Note: Use the Justification submenu in the Text Menu to position text within an editing frame; 
use the Placement submenu to align a text block itself on a page (or change the alignment set-
tings in the Frame Attributes dialog box).

• Placement: Left • Center Horizontally • Right • Top (Header) • Center Vertically • Bot-
tom (Footer) • Position from Page Edge • Position from Page Margin. You must have a 
page-assigned text block selected to use these commands. Otherwise, the commands in the 
Placement submenu are not accessible (they will be grayed out). Choose a command to spec-
ify how you want the text block positioned on the page. Checkmarks appear by the placement 
settings currently in use for the text block. When you change the horizontal or vertical place-
ment of the text block, Finale clears any manual positioning done in the score, and resets the 
H: or the V: positioning settings in the Frame Attributes dialog box to zero. Choose Position 
from Page Edge or Position from Page Margin to align the selected text block with the edge of 
the page or with the page margin, respectively.
Note: To set the default the placement of page-assigned text blocks, choose a different place-
ment from the Placement submenu with no text blocks selected.

• Frame Attributes. Choose this command to display the Frame Attributes dialog box, where 
you can change the positioning of text blocks, and specify whether a text block is assigned to 
a measure, a page, a range of pages, and so on. See FRAME ATTRIBUTES DIALOG BOX for 
details.

• Line Spacing. Choose this command to display the Line Spacing dialog box, where you spec-
ify the exact line spacing (single-spaced, double-spaced, or some other spacing) you want 
Finale to apply to all the text in the text block. For details about using this dialog box, see LINE 
SPACING DIALOG BOX.

• Show Only On Screen. Use this command to determine whether a text block will appear on 
your printed music. When selected, the text block will appear on-screen, but not on your 
printed music. When this command is not selected, the text block will appear on the printed 
page as it appears on-screen. Select this command for editorial comments, compositional 
notes, or other notes you do not want to print. 

• Word Wrap. Deselect this option to disable word wrapping in text blocks.

• Edit Text. Choose this command to display the Edit Text window for the currently selected 
text block. Or, choose this command when no text block handle is selected to cycle through 
and edit all text blocks in your score, including staff and group names. See EDIT TEXT WIN-

DOW for details.
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• Assign to Measure • Assign to Page. These items allow you to specify whether Finale will 
create a text block that is attached to a particular measure or attached to a particular page. 
Note that these commands only affect future text blocks. To change the assignment of a text 
block, see FRAME ATTRIBUTES DIALOG BOX. Select Assign to Measure to create Measure Text 
Blocks that will move with a particular measure. Select Assign to Page to create Page Text 
Blocks that will stay on a particular page.

Size dialog box
How to get there

Click the Text Tool [. Select Other from the Size submenu of the Text Menu.

What it does
The Size dialog box allows you to select any point size for your text. You can also specify Fixed 
Size to display the text at the specified point size, regardless of any reductions that would other-
wise resize the text.

• Point Size. Enter the point size for your text.

• Fixed Size. Select Fixed Size if you want to display the text at the specified point size, regard-
less of any reductions that would otherwise resize the text.

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score.

Baseline Shift dialog box
How to get there

Click the Text Tool [. Select Baseline Shift from the Text Menu.

What it does
The Baseline Shift dialog box allows you to adjust the vertical position of the text without affect-
ing the spacing between lines.
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• Amount. Enter the amount (in measurement units) that Finale should shift the selected text 
characters vertically above or below the baseline. A positive value raises the text, and a nega-
tive value lowers it.

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score.

Tracking dialog box
How to get there

Click the Text Tool [. Select Tracking from the Text Menu.

What it does
The Tracking dialog box allows you to control the amount of horizontal space, in ems, that Finale 
should leave between characters for the selected text.

• Amount. Enter the amount (in ems) of horizontal space, in ems, that Finale should leave 
between characters for the selected text. One em is equivalent to 1/1000 of the point size. Ems 
are proportional measurement units; if you increase or decrease the point size of the text, 
Finale adjusts the distance between characters accordingly, keeping the same proportional dis-
tance, relative to the new font size.

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score.
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Superscript dialog box
How to get there

Click the Text Tool [. Select Superscript from the Text Menu.

What it does
The Superscript dialog box allows you to adjust the vertical position of the text, adjusting the 
spacing between lines by the same amount.

• Amount. Enter the amount (in measurement units) that Finale should shift the selected text 
characters vertically above or below the baseline. A positive value raises the text (making it 
superscript), and a negative value lowers the text (making it subscript).

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score.

Page Offset dialog box
How to get there

Click the Text Tool [. Select a page number insert in a text block then select Edit Page Offset 

from the Text Menu.

What it does
The Page Offset dialog box allows you to enter a number to add to Finale’s current page number.

Select a page number insert in a text block, then choose this command. The Page Offset dialog 
box appears, where you can enter a number to add to Finale’s current page number. 
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• Add to Current Page Number. If you start a movement in a new file, you might want to start 
numbering the first page of the new file at page 5; in this case enter 4 in the text box (page 1 of 
the current file, plus 4 pages offset). To number pages using the current page number (Finale’s 
page number), do not change the Page Offset number (it should be zero).

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score.

Character Settings dialog box
How to get there

Click the Text Tool [. Double-click a text block handle; the editing frame appears. Select the 

text you want to change, then choose Character Settings from the Text Menu.

What it does
The Character Settings dialog box contains all the font settings, as well as the baseline shift, 
superscript, and tracking settings (also available separately in the Text Menu). Use this dialog box 
to see what character formats are in use for the selected text, and to make changes to more than 
one setting at once.
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• Font • Size • Font Style • Effects • Sample. See FONT DIALOG BOX for details about these 
options.

Note: Outline and Shadow are only available in compiled PostScript documents. Also, Finale 
does not provide special support for bitmap fonts. To get the best screen display results, use 
PostScript and TrueType fonts. Use ATM and PostScript fonts if a TrueType version is not 
available for display.

• Baseline Shift. Use Baseline Shift to adjust the vertical position of the text without affecting 
the spacing between lines. Enter the amount, in measurement units, that Finale should shift the 
selected text characters vertically above or below the baseline. A smaller value lowers the text, 
and a larger value raises it.

• Superscript. Use Superscript to adjust the vertical position of the text, adjusting the spacing 
between lines by the same amount. Enter the amount (in measurement units) that Finale 
should shift the selected text characters vertically above or below the baseline. A positive 
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value raises the text (making it superscript), and a negative value lowers the text (making it 
subscript).

• Tracking. Enter the amount of horizontal space, in ems, that Finale should leave between 
characters for the selected text. One em is equivalent to 1/1000 of the point size. Ems are pro-
portional measurement units; if you increase or decrease the point size of the text, Finale 
adjusts the distance between characters accordingly, keeping the same proportional distance 
relative to the new font size.

• Script. Some fonts contain a number of different scripts in the same font. You may choose 
which script to use with this drop-down list.

• OK • Cancel. Click OK (or press enter) to confirm your format settings and return to the score 
or the Edit Text window. Click Cancel to return to the score or the Edit Text window without 
changing any format settings.

Font dialog box

How to get there
This dialog box appears any time you click a Set Font button. You can find a Set Font button in, 
for example, the Measure Number, Articulation Designer, and Text Expression Designer dialog 
boxes.

You can also reach this dialog box by clicking the Text Tool [ and selecting Font from the 

Text Menu or selecting the Lyric Tool k, choose Edit Lyrics from the Lyric Menu and Font 

from the Text Menu.

What it does
In this dialog box you can specify a font (typeface), point size, and style for the text element 
you’re defining. Finale displays sample text to show the effects of your selection.
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• Font. In this scrolling alphabetical list, Finale displays every font installed. Click a font name 
to select it. If any elements in the score use fonts that were present when the document was 
created or edited, but are no longer installed, then the font name appears in the Font text box 
but not in the scrolling font list; see CHECK DOCUMENT FONTS AGAINST SYSTEM FONTS. At 
the top of the dialog box, Finale shows you the actual text you’ve typed, if appropriate.

Note that when you’re creating musical elements such as Articulations, Finale conveniently 
displays the default music font at the top of the list (usually Maestro) as well as in its normal 
alphabetical position.

• Font Style. Choose an appropriate style for the font you are setting. Select Regular, italic, 
bold or bold italic. You can view the effects of these font style changes in the Sample text box.

• Size. In this text box, enter the size, in points (72 per inch), for the textual element you’re 
designing. Each time you enter a number, Finale updates the sample text display to reflect the 
change. See FONTS for some important advice about selecting fonts and type sizes.
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• Effects: Strikeout • Underline • Outline • Shadow • Fixed Size. Check as many of these 
checkboxes as you want; each creates a stylistic change in the font and size you’ve selected as 
follows: strikeout, underline, outline, and ss hh aa dd oo ww.

In some cases, though, you may want to specify a point size for some text that will never 
change, even if you reduce or enlarge the music on the page (lyrics and titles are the most 
common examples). If that’s the case, select Fixed Size; Finale won’t scale this text if the size 
of the music changes.

• Sample display. This display shows how the font selections you have chosen will look.

• Script. Some fonts contain a number of different scripts in the same font. You may choose 
which script to use with this drop-down list.

• Include Printer-Only Fonts. Leave this box unchecked to have the Font dialog box appear 
quicker. Check this box to display fonts in your printer’s memory and not found on your sys-
tem, although this may delay the appearance of the dialog box.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the font change 
you’ve specified. You return to the previous dialog box.

Line Spacing dialog box
How to get there

Click the Text Tool [. Select a text block handle. Choose Line Spacing from the Text Menu.

What it does
Use the Line Spacing dialog box to specify the exact line spacing (single-spaced, double-spaced, 
or any other spacing) you want Finale to apply to all the text in a text block.
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• Automatic: Single (100%) • 1 1/2 (150%) • Double (200%) • Other; ___%. Click Auto-
matic if you want Finale to automatically calculate the line spacing, depending on the font size 
you selected. If you’re using a very large font in a text block, there will be more space between 
those lines than in a text block of 10-point text, although you might have specified single line 
spacing for both cases. Choose Single for single spacing, 1 1/2 if you want the equivalent of 1 
1/2 spaces between lines, or Double for double spacing. If you prefer to enter a value for any 
other amount of spacing, type a number in the percentage text box. For example, a value of 
300% results in triple spacing. The drop-down list automatically changes to Other if a percent-
age other than 100, 150 or 200 is entered.

• Absolute: EVPUs • Inches • Centimeters • Points • Picas • Spaces. Click Absolute if you 
want to set your own spacing instead of having Finale calculate it automatically. Choose a 
measurement unit from the drop-down list (there are 288 EVPUs per inch), then enter the 
exact amount of vertical space you want between the lines of your text, measured from one 
baseline to the next.

• OK • Cancel. Click OK (or press enter) to confirm your line spacing settings and return to the 
score. Click Cancel to return to the score without changing any line spacing settings.

Text Inserts dialog box
How to get there
Choose the Text Inserts command from the Document Settings submenu of the Options Menu.

What it does
Use the Text Inserts dialog box to change the global definition of the sharp, flat, natural, double 
sharp, and double flat signs used as text inserts. The default settings are based on the Maestro font. 
These settings, which are saved with the document, are available if you wish to use a music font 
other than Maestro.



Text Inserts dialog box 33-17      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Symbol: Sharp • Flat • Natural • Double Sharp • Double Flat. Choose the symbol that you 
want to change from the Symbol drop-down list. Any change you make to these global set-
tings affects the appearance of all inserts of the same type in your score. You may want to 
change these if you’re using a font other than Maestro for your music font.

• Symbol: Select. Enter the text font equivalent for the symbol, or click the Select button to dis-
play the Symbol Selection dialog box, where you can choose the character you want to use for 
the currently selected insert. The symbol you select will be used when you place the insert into 
the text.

• Set Font. Click this button to display the Font dialog box, where you can choose the font and 
style for the currently selected insert.
Note: You cannot select a specific size for the insert character in the Font dialog box, since the 
size of the character is proportional to the preceding text. (If no text is entered yet in the text 
block, the insert will be proportional in size to the default font in the Select Default Fonts dia-
log box. See SELECT DEFAULT FONTS DIALOG BOX.)

• Options: Font Size • Baseline Shift • Tracking Before • Tracking After. Enter values to size 
and position the insert proportionally, in relation to the point size of the font preceding the 
insert. Enter percentages for Font Size and Baseline Shift to adjust the size of the font and ver-
tical position of the insert, respectively. Since music characters usually seem smaller than text 
characters at the same font size, you may want a value larger than 100%. Enter values, in ems 
(1/1000 of the current font size), in Tracking Before and Tracking After to adjust the amount 
of horizontal space before and after the insert, respectively.

• Apply Settings to All Symbols. Click this button if you want the current settings (except for 
the selected character) applied to each symbol. Finale updates the font, baseline, and tracking 
values for each symbol.
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• Reset All Symbols. Click this button to restore the default settings, including their default 
Maestro characters, for each symbol. Finale updates all symbols in the score.

• OK • Cancel. Click OK to accept the changes and return to the score, where your changes are 
reflected in each flat, sharp, and natural, double sharp and double flat insert in the score. Click 
Cancel to discard the changes and return to the score.

Standard Frame dialog box
How to get there

Click the Text Tool [. Click a text block handle. Choose Standard Frame from the Text Menu.

What it does
Use the Standard Frame dialog box to specify whether a border appears around the text block, and 
to specify the thickness of the border. Also specify the amount, in measurement units, to indent 
the text from the frame. This setting affects the text block both on-screen and on printed music.

• Show Border. Use this option to determine whether a border will appear around the text 
block. When this option is selected, Finale displays a border around the text block using the 
line thickness specified in this dialog box. When this option is not selected, the text block will 
appear without a border.

• Expand Horizontally • Expand Vertically. These options control how text typed into the 
score will flow into an editing frame. Sometimes you will want the frame to remain a fixed 
size, while other times you’ll want it to expand as you type. To have the frame automatically 
expand as you type, double-click a location in the score and start entering text without drag-
ging to create a frame; or, display the Frame Attributes dialog box for a text block already in 
the score and select the Expand Horizontally option. The edge of the frame will expand left or 
right—depending on its horizontal alignment—as long as you enter text, until you press enter 
(type a carriage return) to start a new line. To allow an unlimited number of lines of text in a 
frame, double-click a location in the score and start entering text without dragging to create a 
frame; or, display the Frame Attributes dialog box for a text block already in the score and 
select the Expand Vertically option. The edge of the frame will expand up or down—depend-
ing on its vertical alignment—as long as you enter text.
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Neither of these options will be selected if you create a text block by double-clicking and 
dragging to create the size frame that you want the text to flow into. Dragging the frame on-
screen to adjust the text block’s width or height will also deselect these settings. Make sure 
that Expand Horizontally is not selected if you want the text to wrap when it reaches the edge 
of the frame, and that Expand Vertically is not selected if you want the text to flow into the 
height of the existing frame.

The sides of the frame show a single line on-screen to indicate that the frame will expand hor-
izontally or vertically. A double line indicates that the frame is a fixed size; drag the side of the 
frame to resize it. 

• Line Thickness. Enter the line thickness, in current measurement units, for the border.

• Inset Text. Enter the distance, in measurement units, that you want the text to be inset from 
the border or the frame shape. This value is always used, even if you don’t show the border or 
shape. 

• OK • Cancel. Click Cancel to return to the score without changing the settings for the frame 
that the text flows into. Click OK (or press enter) to confirm your settings and return to the 
score.

Custom Frame dialog box
How to get there

Click the Text Tool [. Click a text block handle. Choose Custom Frame from the Text Menu.

What it does
The Custom Frame dialog box contains an option where you specify the amount to inset a text 
block from the custom shape.
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• Shape • Select. The number in the Shape text box identifies the enclosure shape by number. 
To select one visually—or to create a new one—click Select. The Shape Select dialog box will 
appear; if you’ve loaded a Shape Library into your piece, such as the one provided with 
Finale, the shapes will appear in this selection dialog box. Either double-click on to select it, 
or click Create to enter the Shape Designer, where you can create your own (see SHAPE 
DESIGNER DIALOG BOX). In either case, when you return to the Custom Frame dialog box, 
Finale places the correct shape number in the text box.

• View. You can magnify or reduce the view custom frame as you’re working on it by choosing 
a magnification level from this drop-down list. (100% is actual size.) Use it if you want to 
“zoom in” on a very small custom frame, or “zoom out” to see all of a very large custom 
frame; neither has any effect on the size of the custom frame as it will appear in the score.

• Show: Handle • Shape • Text. These checkboxes govern what elements of your custom frame 
appear in the dialog box. (A selected checkbox means that the object will appear.)

• Distance from Handle. These are two small circular handles in the a Custom Frame dialog 
box display; a black one and white one (but they’re initially superimposed, so that all you can 
see is the white one). The white circle represents the location of the custom frame’s handle 
when it appears in the score.
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If you want to position the black dot relative to the white dot numerically, you can enter mea-
surement values in the two text boxes. The H: text box sets the horizontal distance from the 
black dot to the white dot. (a positive number moves the white dot to the right, a negative 
number moves it to the left); the V: text box sets the vertical distance (a positive number 
moves the white dot upward, a negative number moves it downward). After entering numbers 
into these text boxes, drag anywhere in the display area to update the screen image.

• Inset Text. Enter the distance, in measurement units, that you want to inset the text block from 
the shape. Finale always uses this value, even if the frame is hidden.

Although you can edit the text flowing into custom frames on the screen, custom frames can-
not be resized on the screen, nor can they be set to expand automatically to accommodate 
more text. To take advantage of on-score resizing and expanding, see STANDARD FRAME DIA-

LOG BOX earlier in this section.

Note: If you create a custom shape, Finale will display the text in a standard editing frame 
while you’re editing it on-screen. When you’ve finished editing, the text will be shown on-
screen, within or surrounding the custom shape you selected.

• OK • Cancel. Click OK (or press enter) to confirm the construction of your custom frame and 
return to the score. Click Cancel if you decide note to create or edit a custom frame.

Frame Attributes dialog box
How to get there

Click the Text Tool [. Click a text block handle, then choose Attributes from the Text Menu. 

Or, shift-double-click a text block handle.

What it does
For measure-assigned text blocks, use the Frame Attributes dialog box to specify the staff and 
measure to which Finale should assign the text block; for page-assigned text blocks, specify 
which pages a text block will appear on, and position the text block vertically and horizontally on 
the page. The dialog box appears with the settings already selected for measure- or page-assigned 
text blocks.
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• Attach to: Page: Single Page • All Pages • Page Range • Left Pages • Right Pages; 
__Through__. Click Page to assign the text block to one or more pages. Choose an item from 
the drop-down list to have Finale show the text block on a single page, all pages, a range of 
pages, left-facing (even-numbered) pages or right-facing (odd-numbered) pages, then specify 
the range of pages (with the exception of single page and all pages). Enter the numbers of the 
pages where the text block will appear (you’d select Left Pages, and 6 Through 10 to display 
the text block on every left page between pp. 6–10, for example). To show the text block on a 
single page, choose Single Page, then enter the page number in the first text box. To display 
the text block on the first page through the end of the piece, choose All Pages. To show the text 
block on every page, starting at page 6, you’d select Page Range and enter 6 Through 0, or 
enter 6 and leave Through blank.

Note: A text block assigned to a measure will only appear on the page containing that mea-
sure, so the page settings aren’t available for measure-assigned text blocks.

• Attach to: Measure • [Staff names]. Click to assign the text block to a measure. In the Mea-
sure text box, enter the measure number you want the text block to be assigned to. From the 
Staff drop-down list, choose the staff you want associated with the measure-assigned text 
block. Finale aligns and positions the text block in relation to this staff.
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Note: When you change whether a text block is assigned to a page or a measure, Finale resets 
the H: and V: values to zero. It also sets Measure to 1 or Page to 1 (or the current page if 
you’re in Page View).

• Alignment and Positioning: Horizontal: Left • Center • Right; Vertical: Top (Header) • 
Center • Bottom (Footer); Position from: Page Margin • Page Edge; H: • V:. Use the Hor-
izontal drop-down list to position a page-assigned text block horizontally between the left and 
right page edges or margins. Choose Left or Right to position the text block flush with the left 
or flush with the right page edge or margin. Choose Center to center the text block between 
the left and right page edges or margins. When you select a Horizontal option Finale resets the 
Alignment and Positioning: H: value to zero, and positions the text block horizontally, 
depending on the Position from selection. 

Use the Vertical drop-down list to position a page-assigned text block vertically between the 
top or bottom page edges or margins. Choose Top (Header) or Bottom (Footer) to place the 
text block at a distance measured from the top or measured from the bottom of the page edge 
or margin. Choose Center to center the text block between the top and bottom edges or mar-
gins. When you select a Vertical option Finale resets the Alignment and Positioning: V: value 
to zero, and positions the text block vertically, depending on the Position from selection.

Use the Position from drop-down list to have Finale calculate a page-assigned text block’s 
position starting from either the page margin or page edge. Select Page Margin to have Finale 
measure the text block’s position starting from the page margin. Select Page Edge to measure 
the text block’s position from the page edge.

Note: The Horizontal, Vertical and Position from options are only available for page-assigned 
text blocks (Attach to: Page is selected).

Use the H: and V: text boxes to position a measure- or a page-assigned text block horizontally 
and vertically. For measure-assigned text blocks (Attach to: Measure is selected), enter values 
in H: and V: to position the text block from the top-left of the measure. For page-assigned text 
blocks (Attach to: Page is selected), enter values in H: and V: to position the text block on the 
page, based on your settings in the Alignment and Positioning group box. Enter a value for H: 
to change the horizontal position; a positive number moves the text block to the right; a nega-
tive number moves it to the left. Enter a value for V: to change the vertical position; a positive 
number moves the text block higher; a negative number moves it lower.

Note: The H: and V: text boxes in the Alignment and Positioning group box are used for both 
measure- and page-assigned text blocks.

• Right Page Alignment and Positioning: Use Right Page Positioning; Horizontal: Left • 
Center • Right; H: • V:. Select Use Right Page Positioning if you want Finale to position a 
page-assigned text block differently on right-facing pages. When this option is selected, you 
can set separate horizontal alignment and H: and V: settings for right-facing pages. Finale uses 
the settings in the Alignment and Positioning group box for left-facing (even-numbered) 
pages, and the settings in the Right Page Positioning and Alignment group box for right-facing 
(odd-numbered) pages in the score.

Use the Horizontal settings to position page-assigned text blocks horizontally on right-facing 
pages when Use Right Page Positioning is selected. The settings work the same as the Hori-
zontal settings in the Alignment and Positioning group box, but are used for right-facing pages 
only.
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Use the H: and V: text boxes to position page-assigned text blocks on right-facing pages when 
Use Right Page Positioning is selected. These settings work the same as the H: and V: settings 
in the Alignment and Positioning group box, but are used for right-facing pages only.

• Position from Edge of Frame. This option is automatically selected for text blocks created in 
Finale. If you open a file from a version older than 3.7, this option is not selected; text blocks 
in your file will be positioned as they were in the previous version. This checkbox also affects 
line spacing in the text block. Finale also looks at font changes within the line when changing 
fonts.

• OK • Cancel. Click Cancel to return to the score without updating any positioning for the text 
block. Click OK (or press enter) to confirm your settings and return to the score.

Edit Text window
How to get there
To edit all text blocks in the document (text blocks, and staff and group names): Click the Text 

Tool [. Choose Edit Text from the Text Menu.

To edit a single text block: Click the Text Tool. Click a text block handle. Choose Edit Text from 
the Text Menu.

To edit a staff name: Click the Staff Tool s. Click a staff handle, then choose Edit Staff 

Attributes from the Staff Menu. Click Edit next to the full or abbreviated staff name in the Staff 
Attributes dialog box. (Or, ctrl-click a staff name handle on-screen.)

To edit a group name: Click the Staff Tool. Click a group handle, then choose Edit Group 
Attributes from the Staff Menu. Click Edit next to the full or abbreviated group name in the Group 
Attributes dialog box. (Or, ctrl-click a group handle on-screen.)

Note: You can also edit lyrics using Finale’s text editing window. See EDIT LYRICS WINDOW.

What it does
The Edit Text window displays text in the same fonts and styles that will appear on the screen and 
on printout. A rectangle around a portion of text indicates an insert command was used to display 
the date, composer, or similar text items (see TEXT MENU for a complete list of inserts). The Edit 
and Text menus are available when the window appears so you can copy and paste text, change 
fonts and styles, and carry out other editing tasks. Note that text always appears left-justified 
within the display area and the commands in the Justification submenu are not available from the 
Text Menu when the Edit Text window is displayed; to change the justification of the text, edit the 
text block on-screen, or change the justification of staff and group names in the Position Staff 
Name and Position Group Name dialog boxes. For details, see TEXT MENU and EDIT MENU, and 
see POSITION STAFF NAME... DIALOG BOXES and POSITION GROUP NAME...DIALOG BOXES.
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• Editing: [Item Type] • ID [ID #]. These settings identify the text block you’re currently edit-
ing. The type of text block being edited—full or abbreviated staff name, group name, or block 
of text—appears first (Item Type). The text’s Finale-assigned ID number also appears.

Up and down arrows appear when you choose Edit Text when no text blocks are selected. 
Click the arrows to cycle through all the text blocks in the score.

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score. Click 
Cancel to return to the score without changing the settings.

Text
You can place text, in any font and size, anywhere in a Finale score. Different tools, however, are 
ideal for different kinds of text. The table below will help you find instructions for creating the 
kind of text you’re looking for.
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Text blocks
A text block can be almost any piece of text: a note to the conductor, a page of dialogue, perfor-
mance instructions, or an extra verse of lyrics, for example. You can place block text, in any font 
and size, anywhere in the score.

Text blocks created in Scroll View and text blocks created in Page View are treated differently. 
Finale assigns a text block to a measure if you are in Scroll View when the text block is created. 
To create a page-assigned text block, you must be in Page View.

To create text in a frame that automatically expands as you type

• Click the Text Tool [. The Text Menu appears.

• Double-click the document window where you want to place text. The editing frame 
appears, with a flashing cursor to indicate the insertion point.

• Type the text directly into the score without dragging to create a frame. Press enter (type 
a carriage return) to start a new line. The frame expands horizontally and vertically to accom-
modate the text you enter.

A single dashed line indicates that the frame will expand vertically and /or horizontally as you type.

To create text within a fixed-size frame

• Click the Text Tool [. The Text Menu appears.

• Double-click the document window, and drag to create a rectangle to accommodate your 
text. An editing frame of the size you create appears, with a flashing cursor to indicate the 
insertion point. The placement of the insertion point—left, center, or right—depends on the 
justification options selected in the Text Menu.

To create these… Use this tool… …and see this entry

Lyrics LYRICS TOOL LYRICS

Page numbers TEXT TOOL PAGE NUMBERS

Notes to the conductor TEXT TOOL TEXT BLOCKS

Titles TEXT TOOL TITLES

Copyright notices TEXT TOOL COPYRIGHT NOTICES

Text expressions (arco, etc.) EXPRESSION TOOL EXPRESSIONS

Long text expressions TEXT TOOL TEXT BLOCKS

Explanatory text TEXT TOOL TEXT BLOCKS

Chord symbols CHORD TOOL CHORD SYMBOLS
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A double dashed line indicates that the frame is a fixed size; it will not expand as you type.

• Enter the text you want displayed. The placement of the text within the frame—left, center, 
or right—depends on the justification options selected in the Text Menu. The words wrap 
when you reach the side of the frame.

• To resize the frame to accommodate additional text, drag the side of the frame to the 
desired size. 

To edit text on-screen

• Click the Text Tool [. The Text Menu appears.

• Double-click a text block handle. The editing frame appears around the text.

• Click within the selected text block to edit the text. The insertion point appears where you 
click. Select some text, then use the Text Menu to change the character or text block settings 
for the selected text.

• Use the Placement submenu of the Text Menu or Frame Attributes dialog box to change 
a text block’s attributes, such as whether it is assigned to a measure or a page or pages, 
how it’s positioned, and so on. 

To resize a text block on-screen
If a standard frame is set for a text block (Standard Frame is selected in the Text Menu), you can 
resize the text block on-screen by dragging its frame. If you’re using a custom frame for a text 
block (Custom Frame is selected in the Text Menu), see “To resize a custom frame” next for 
instructions.

• Click the Text Tool [. The Text Menu appears.

• Double-click a text block handle. The editing frame appears around the text.

• To change the text block’s shape or size on-screen, drag any side of the frame to stretch 
the shape. 

To resize a custom frame

• Click the Text Tool [. The Text Menu appears.

• Click a text block handle, then choose Custom Frame from the Text Menu. The Custom 
Frame dialog box appears.

• Click Select. If a shape was already selected for the custom frame, the Shape Designer 
appears. If no shape was selected, click Create in the Shape Selection dialog box.
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• Resize the shape in the Shape Designer. For details, see SHAPE DESIGNER DIALOG BOX.

• Click OK or Select until you return to the Custom Frame dialog box, where you can see 
how the text flows into the selected shape. When the text flows into the frame the way you 
want it to, click OK to return to the score.

Note: As in previous versions, custom shapes may be used for more than one text block in the 
score. If the shape is used elsewhere, changing the shape for one text block will change all 
occurrences of the shape in the score.

To assign a text block to one or more pages

• Click the Text Tool [. The Text Menu appears.

• Click a text block handle, then choose Frame Attributes from the Text Menu. Or, shift-
double-click a text block. The Frame Attributes dialog box appears.

• Click to select Attach to: Page, if it isn’t already selected. 

• Select an item from the drop-down list. Choose Single Page to show the text block on one 
page; choose All Pages to show it on every page; or choose Left Pages or Right Pages to show 
it on left or right pages.

• Set the page range. Enter the numbers of the pages where the text block will appear (you’d 
select Left Pages and 6 Through 10 to show the text block on every left page between pp. 6–
10, for instance). To show the text block on a single page, enter the page number in the first 
page text box. To display the text block through the end of the piece, enter zero in the second 
text box, or leave the text box empty. For example, to show the text block on every page, start-
ing at page 6, you’d select All Pages and enter 6 Through 0, or enter 6 and leave Through 
blank.

• Use the other settings in the Frame Attributes dialog box to adjust the text block’s posi-
tion in the score, then click OK to return to the score. 

To assign a text block to a measure

• Click the Text Tool [. The Text Menu appears.

• Click a text block handle, then choose Frame Attributes from the Text Menu. Or, shift-
double-click a text block handle. The Frame Attributes dialog box appears.

• Click to select Attach to: Measure and then, into the text box, type the number of the 
measure you want the text block assigned to. 

• From the Staff drop-down list, choose the name of a staff you want associated with the 
measure-assigned text block. Finale will align and position the text block in relation to this 
staff.

• Use the other settings in the Frame Attributes dialog box to adjust the text block’s posi-
tion in the score, then click OK to return to the score. 
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To position text blocks on-screen

• Click the Text Tool [. The Text Menu appears.

• Drag a text block’s handle to adjust its placement in the score. Drag-enclose or shift-click 
additional text block handles to select them. You can drag multiple text blocks on the score to 
position them.

To position page-assigned text blocks (Text Menu)
• Choose Page View from the View Menu, if it isn’t already selected. 

• Click the Text Tool [. The Text Menu appears.

• Click a page-assigned text block handle, then choose Placement from the Text Menu. 

• Position the text block from the page margin or the page edge using the Placement sub-
menu. Choose Position from Page Edge or Position from Page Margin from the Placement 
submenu of the Frame Menu to align the text block from the page edge or from the page mar-
gin, respectively.

• Position the text block horizontally. Choose Left to place the text block on the left edge or 
margin of the page; choose Center Horizontally to center it between the left and right edges or 
margins; or choose Right to align it on the right edge or margin. 

• Position the text block vertically. Choose Top (Header) to place the text block on the top 
edge or margin of the page; choose Center Vertically to center it vertically between the top and 
bottom edges or margins; and choose Bottom (Footer) to align it on the bottom edge or mar-
gin.

Note: When you change the horizontal or vertical placement, Finale clears any manual posi-
tioning that was done in the score, and resets the H: or the V: positioning settings, respectively, 
in the Frame Attributes dialog box to the new position.

To position page-assigned text blocks (Frame Attributes dialog box)
• Choose Page View from the View Menu, if it isn’t already selected. 

• Click the Text Tool [. The Text Menu appears. 

• Click a text block handle, then choose Attributes from the Text Menu. Or, shift-double-
click a text block handle. The Frame Attributes dialog box appears.

• Use the Alignment and Positioning settings to position the text block. 

Note: The Horizontal, Vertical, and Position from options in the Alignment and Positioning 
group box are only available when you select Attach to: Page. When Attach To: Measure is 
selected, these options are not available, because a text block assigned to a measure only 
appears on the page containing that measure.

• Position the text block horizontally. Choose Left from the Alignment and Positioning: Hori-
zontal drop-down list to place the text block on the left edge or margin of the page; choose 
Center to center it between the left and right edges or margins; or choose Right to align it on 
the right edge or margin.
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• Position the text block vertically. Choose Top (Header) from the Alignment and Positioning: 
Vertical drop-down list to place the text block on the top edge or margin of the page; choose 
Center to center it between the top and bottom edges or margins; and choose Bottom (Footer) 
to align it on the bottom edge or margin.

Note: When you change the horizontal or vertical page alignment, Finale clears any manual 
positioning that was done in the score, and resets the H: or V: settings, respectively, to the new 
position.

• Use the Position from drop-down list to position the text block from the page margin or 
the page edge. Choose Page Margin from the Position from drop-down list to have Finale cal-
culate the text block’s position starting from the page margin. Choose Page Edge to have 
Finale measure the text block’s position starting from the edge of the page.

• Set the positioning distance. Enter values into the H: and V: text boxes in the Alignment and 
Positioning group box for the distance to position the text block horizontally and vertically on 
the page, based on the other settings in the Alignment and Positioning group box. 

• Click OK to confirm your settings and return to the score. 

To position measure-assigned text blocks (Frame Attributes dialog box)
• Choose Scroll View from the View Menu, if it isn’t already selected. 

• Click the Text Tool [. The Text Menu appears.

• Click a measure-assigned text block handle, then choose Attributes from the Frame 
Menu. Or, shift-double-click a measure-assigned text block handle. The Frame Attributes dia-
log box appears.

• Set the positioning distance. Enter a value in the H: text box in the Alignment and Position-
ing group box for the distance to position the text block horizontally from the upper-left of the 
staff associated with the measure. A larger value moves text to the right; a smaller value to the 
left. Enter a value in the V: text box for the distance to position the text block vertically from 
the upper-left of the staff associated with the measure. A larger value moves text down; a 
smaller value up. 

• Click OK to confirm your settings and return to the score. 

To position page-assigned text blocks on left- and right-facing pages (Frame 
Attributes dialog box)
If you’re using running headers or footers in your score, you might want to position a text block in 
the header or footer near the “outside” edges or margins (the left or right edges, respectively) of 
each left-facing (even-numbered) or right-facing (odd-numbered) page, as opposed to always 
positioning the text block in the same place on every page. This is easily done using special posi-
tioning settings for right-facing pages in the Frame Attributes dialog box; follow the steps out-
lined here.

• Choose Page View from the View Menu, if it isn’t already selected. 

• Click the Text Tool [. The Text Menu appears.
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• Click a page-assigned text block handle, then choose Frame Attributes from the Text 
Menu. Or, shift-double-click a page-assigned text block handle. The Frame Attributes dialog 
box appears.

• Use the Alignment and Positioning settings in the Frame Attributes dialog box to posi-
tion the text block on every page in the selected page range. See “To position page-
assigned text blocks (Frame Attributes dialog box)” earlier in this section.

• Click Use Right Page Positioning to place the text block differently on right-facing (odd-
numbered) pages. 

• Position the text block horizontally on right-facing pages. Choose Left from the Right 
Page Alignment and Positioning: Horizontal drop-down list to place the text block on the left 
edge or margin of the right-facing page; choose Center to center it between the left and right 
edges or margins; or choose Right to align it on the right edge or margin. (Finale resets the 
Right Page Alignment and Positioning: H: setting to zero so the left, right, or center of the text 
block is aligned horizontally with the page edge or margin.)

• Set the positioning distance. Enter values into the H: and V: text boxes in the Right Page 
Alignment and Positioning group box for the distance to position the text block horizontally 
and vertically on right-facing pages, based on the Right Page Alignment and Positioning: Hor-
izontal setting, and the Vertical and Position from selections in the Alignment and Positioning 
group box. 

• Click OK to confirm your settings and return to the score. 

To delete a text block
• Select a text block handle or drag-enclose to select a group of handles. Press delete. 

To specify a default font for text blocks
• Choose Select Default Fonts from the Options Menu. The Select Default Fonts dialog box 

appears.

• From the Text drop-down list, choose Text Block and click the corresponding Set Font 
button. The Font dialog box appears in which you can select the font you want to use for your 
text blocks.

• Click OK twice. You return to the score. Now any new text you create with the Text Tool will 
use the font you selected.

Titles
A title is created and positioned with the Text Tool. If you want to create the title on a page of its 
own, see TITLE PAGE.

To create extra room at the top of the page
Depending on the format of your piece, you may want the music on the first page to begin slightly 
lower on the page to allow room for a title space.
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• Scroll to the beginning of the piece. Click the Page Layout Tool f. Finale displays the 

systems on the first page, representing each as a rectangle with handles at the upper-left and 
lower-right.

• Click in the middle of the first staff system and drag it downwards. When you drag the top 
system down, all subsequent systems move down on the page as well. If you want more preci-
sion, try this: Choose Edit System Margins from the Systems submenu of the Page Layout 
Menu. Click the top system’s handle, and then enter a larger value in the topmost text box at 
the right side of the screen. These numbers represent the system margins.

• Click the upper left handle of the first staff system and drag it upwards until it overlaps 
the top page margin. If you later use Space Systems Evenly, Finale will adjust the Distance 
Between Systems value. Because we don’t want the space for the title to be considered in this 
spacing, we needed to adjust the top margin of the system.

To add a title

• Click the Text Tool [. 

• Select Page View from the View Menu. 

• Double-click where you want the title. The text editing frame appears.

• Select font, size and style from the Text Menu. Skip this step if the default Text Block set-
tings are the ones you want to use. See SELECT DEFAULT FONTS DIALOG BOX.

• Select Title from the Inserts submenu of the Text Menu. If you haven’t defined a title in the 
File Information dialog box, either select File Info from the File Menu and fill in the appropri-
ate information, or just type in the title you want to use.

• Select Frame Attributes from the Text Menu. The Frame Attributes dialog box appears.

• Select Page. Choose Single Page from the drop-down list and type 1 in the first text box. 
(These should be the default settings).

• Select the alignment and positioning options from the alignment and positioning drop-
down lists. 

• Click OK (or press enter). 

To move or delete a title

• Click the Text Tool [, if it’s not already selected. A handle appears on each title.

• Drag the title’s handle to move it; select the handle and press delete to remove it. 

To specify a default font for titles
The default font for titles is the same as the default font for all text blocks. See TEXT BLOCKS–To 
specify a default font for text blocks.
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Title page
This entry contains instructions for creating a separate title page with no music on it. If you want 
the title to appear at the top of the first page of music instead, see TITLES.

To create a title page

• Scroll to the beginning of the piece. Click the Page Layout Tool f. 

• Choose Insert Blank Pages from the Page Layout Menu. 

• Click the Text Tool [. You’re about to create the first piece of text (title) information.

• Double-click where you want the first piece of text. The text editing frame appears.

• Select font, size and style from the Text Menu. Skip this step if the default Text Block set-
tings are the ones you want to use. See SELECT DEFAULT FONTS DIALOG BOX.

• Select Title from the Inserts submenu of the Text Menu. If you haven’t defined a title in the 
File Information dialog box, either select File Info from the File Menu and fill in the appropri-
ate information, or just type in the title you want to use.

• Select Frame Attributes from the Text Menu. The Frame Attributes dialog box appears.
• Select Page. Choose Single Page from the drop-down list and type 1 in the first text box. 

(These should be the default settings).
• Select the alignment and positioning options from the alignment and positioning drop-

down lists. 
• Click OK. Repeat the process with any other information that you want to appear on the title 

page, selecting various Text Inserts from the Text Inserts submenu of the Text Menu, or typing 
in text that is needed. See TITLES, for information on moving and deleting titles.

Date stamps
If you create a time stamp or a date stamp, Finale will automatically print the current time or date 
on your document each time you print it. To add a time or date stamp, you use the Text Tool.

To create a time or date stamp

• Click the Text Tool [. 

• Double-click where you want the Date or Time stamp on the page. The text editing frame 
appears. 

• Select font, size and style from the Text Menu. Skip this step if the default Text Block set-
tings are the ones you want to use. See SELECT DEFAULT FONTS DIALOG BOX.

• Select Date or Time from the Inserts submenu of the Text Menu. 
• Select Frame Attributes from the Text Menu. The Frame Attributes dialog box appears.
• Select Page. Choose Single Page from the drop-down list and type 1 in the first text box. 

(These should be the default settings).
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• Specify where you want this date stamp to appear, using the options in the Frame 
Attributes dialog box. Use the alignment and position drop-down lists and the Attach To 
options to place the date or time stamp. See FRAME ATTRIBUTES DIALOG BOX for more infor-
mation.

• Click OK to exit the Frame Attributes dialog box. The date stamp appears on the pages you 
specified, with the justification you selected.
To move the date stamp, drag its handle; select the handle and press delete to remove it.

To change the date format for date stamping
• Choose Document Options from the Document Settings submenu of the Options Menu. 

At the bottom of the box that appears, you see three options listed under the Date Format 
heading. You can choose the short format (2/14/97), the medium format (February 14, 1997) 
or the long format (Sunday, February 14, 1997).

• Click the date format you prefer. Click OK (or press enter). 

Copyright notices
A copyright notice, often added to the bottom of the first (or every) page of a published score, is a 
text block in Finale; while pressing alt, type 0169 on the numeric keypad to create the copyright 
symbol itself (©). See TITLES for instructions on creating text blocks incorporating Text Inserts.

Page numbers
To add a page number, use the Text Tool in Page View.

To add a page number

• Click the Text Tool [. 

• From the View Menu, select Page View.
• Double-click where you want the page number to appear. The text editing frame appears.
• From the Text Menu, select font, size and style. Skip this step if the default Text Block set-

tings are the ones you want to use. See SELECT DEFAULT FONTS DIALOG BOX.
• From the Text Menu, choose Inserts, then Page Number. 
• From the Text Menu, choose Frame Attributes. The Frame Attributes dialog box appears.
• Click on Page, then choose All Pages from the drop-down list. 
• Select the alignment and positioning options from the alignment and positioning drop-

down lists. See FRAME ATTRIBUTES DIALOG BOX for details. To use the left and right facing 
pages feature see TEXT BLOCKS–To position page-assigned text blocks on left- and right-fac-
ing pages.

• Click OK (or press enter) to return to the score. 
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To change the page number offset

• Click the Text Tool [. 

• Select Page View from the View Menu. 

• Double-click the handle of the text block containing the page number. The text editing 
frame appears.

• Select the page number Text Insert so that the number is highlighted. 

• Select Edit Page Offset from the Text Menu. The Page Offset dialog box appears.

• Type in the number to add to the current page number. If you are on page one and want 
the page numbers to start at 10, type 9.

• Click OK. You return to the score, and the page numbers are updated to reflect the new offset.

To move or delete a page number

• Click the Text Tool [. A handle appears on the page number.

• Drag the number’s handle to move it. Select the handle and press delete to remove it.

Running headers
A running header is a piece of text appearing at the top of every page of a score—a title, date, or 
copyright notice, for example. (A running footer appears at the bottom of every page.) You can 
create any such text with the Text Tool. You can even specify a running header to appear on the 
right or left pages only, so that you can have different running headers on each of two facing 
pages. See TITLES and TEXT BLOCKS–To position page-assigned text blocks on left- and right-fac-
ing pages for full instructions on creating headers and footers.
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